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I. INTRODUCTION AND RATIONALE 
 

A. GOALS 
 

Project Goal:  Given a computer loaded with Microsoft PowerPoint and an 

icon for the application on the desktop, the 3rd grade students in computer 

class with teacher and/or peer assistance will use the PowerPoint software 

application to create a 2-slide presentation, which will include use of text 

boxes, clip art, slide transitions and sound; and they will save the work in a file 

located in their work folder on the school server. 

In order to be prepared for middle school, high school and post-high school 

settings, elementary students need to have a solid grasp of a core set of 

technological tools.  These tools include, but are not limited to, word 

processing, internet browsers, spreadsheets and presentation software.  

Establishing a foundation for building competence in use of presentation 

software is the focus of this educational goal.  PowerPoint has been selected 

as the presentation software that students will learn to add to their arsenal of 

tools for presenting reports on various topics.  Whether for an assignment in 

computer class or as a supplement to classroom activities, PowerPoint can be 

a useful tool.  

In Bob Regan’s article (2008) on why we should teach 21st century skills, he 

quotes arts and technology instructor, Colette Stemple, “’Students begin to see 

themselves and their abilities differently,’ says Stemple.  ‘By activating the 

creative side of the brain, students improve their learning and thought 

processes.  What we need in industry are more creative thinkers. What we’re 
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creating with visual and multimedia technology programs are students who can 

see an issue from all angles and present it in meaningful, compelling ways.  

These are the skills students need to thrive in the 21st century.’”  

B. NEED 
 

Technology is prevalent in so many aspects of our lives, at home and at 

work.  Learning what technological resources are available and how to use 

them correctly and responsibly is an important part of educating today’s 

students.  In her article “PowerPoint Effective, But Often Misused”, Joyce 

Valenza (2001) states why education of students on the proper use of 

PowerPoint software is important.  “These early presentation efforts are the 

forerunners of speeches that our students will eventually make to their clients, 

PTOs, corporate boards, and religious groups.” 

The International Society for Technology Education (ISTE) is a nonprofit 

membership organization that provides leadership and service to improve 

teaching, learning, and school leadership by advancing the effective use of 

technology in PK–12 and teacher education.  The National Education 

Technology Standards (NETS) defined by ISTE are used in every U.S. state 

and many countries and have been credited with significantly influencing 

expectations for students and creating a target of excellence relating to 

technology. 

Following these standards (ISTE, 1998), students by grade 5 should: 

• Use general purpose productivity tools and peripherals to support 

personal productivity, remediate skill deficits, and facilitate learning 

throughout the curriculum. 
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• Use technology tools (e.g., multimedia authoring, presentation, Web 

tools, digital cameras, scanners) for individual and collaborative writing, 

communication, and publishing activities to create knowledge products 

for audiences inside and outside the classroom.  

Currently instruction of PowerPoint begins in 5th grade and only gives these 

students a basic introduction to the tool.  The desired goal is that 5th grade 

students will be able to use many of the features of PowerPoint, not just the 

basics.  To correct this gap, PowerPoint instruction has been targeted to begin 

in 3rd grade, providing a basic knowledge of the software that will be reinforced 

and expanded in 4th & 5th grades.  

 
C. TIME FRAME 

 
This content is designed to be taught in two 30-minute class sessions.  It will 

serve as the prerequisite for additional PowerPoint lessons and project 

assignments.  Ideally, students will be assigned their own PC, but if class size 

dictates, students will be paired and allowed time during the subsequent class 

meeting to finish the assignment.   

D. DELIVERY 
 

This instruction will take place in a computer lab of 21 networked PC’s in a 

traditional instructional setting.  Computers in this lab are organized in a 

horseshoe configuration with students facing away from the teacher.  

Instruction will include lecture and demonstration on the subject.  Students will 

be required to turn toward the front to listen to teacher instruction and observe 

visual demonstrations before attempting steps on their own.  A whiteboard will 

be available for displaying key terminology and making notes for this lesson. A 
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laptop connected to a digital projector will be utilized by the instructor for the 

purpose of demonstrating the steps to the entire class.   A sample presentation 

will shown to give students an idea of what can be done with this presentation 

tool.  Students will be led step-by-step through the process for their assignment 

and given time to work on each step.   
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II. RELEVANT LEARNER AND PERFORMANCE CONTEXT 
 

A. TARGET POPLULATION 
 

The target population for this lesson is the 3rd grade students at a small rural 

elementary school.  Typical class size at the school is 25-30.   Students of all 

abilities are included in this class.   

Students in this group that have attended this district for the prior two years 

have learned basic computer skills through weekly computer classes.   They 

are familiar with the facilities and the equipment.  In the past, they have 

exhibited a strong desire to attend computer class and learn new technology. 

 
B. ENTRY LEVEL SKILLS 

 
These students have a certain number of computer-related skills that they 

have gained from prior instruction during first and second grade.  Some 

students have also acquired some of these skills through access to 

technological tools in the home. 

The expected entry level skills include powering up the computer and 

monitor, logging onto the computer network, identifying icons on the desktop, 

starting an application by using the mouse to double-click an icon on the 

desktop, selecting menu choices using a mouse, locating student folder/files in 

the network directory structure and shutting down the computer.   

There may be some exceptions due to transfer students from districts that 

do not have prior computer instruction or other exposure to use of the 

computer.   These students will assisted by the instructor and/or peers as 

needed to help them master these entry skills.   
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C. SPECIAL NEEDS LEARNER ADJUSTMENTS 

 
Adjustments for special needs learners will be made for physical and 

instructional limitations.  Computers are located on tables that are wheelchair 

accessible.   Screen display attributes can be set to lower resolution for 

students with visual problems.  There are also several Accessibility settings in 

the Windows operating system that can be utilized to offset difficulties with 

vision, hearing or mouse/keyboard manipulation.  Students with reading or 

other visual processing needs will be paired up with a peer to assist them.  

Advanced students who are not involved in peer assistance can be given an 

additional project or an extension to the defined project. 

D. PERFORMANCE CONTEXT 
 

Students will receive instruction in the computer lab, equipped with 21 

networked PC computers.  All computers have been installed with the same 

configuration to provide consistency for the purpose of instruction.   

Most students will be able to work individually on a computer but some may be 

paired up due to class size.  These paired students will be allowed to work 

individually in the subsequent class to complete the assignment. Students will 

be given assistance from the instructor and their peers for the purpose of 

achieving this instructional goal.   

Due to the horseshoe configuration of the room, it will be necessary to gain 

attention of students during instructional segments and demonstrations to 

ensure that students understand the concepts and instructions.  Information will 

be given in small segments to allow students to apply concepts as they go.   
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III. SUBORDINATE SKILLS ANALYSIS 
 
 
(See Appendix A) 
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IV. PERFORMANCE OBJECTIVES 
 
Terminal Objective (T.O.):  Given a computer loaded with Microsoft PowerPoint and an 

icon for the application on the desktop, the 3rd grade students over the period of two 

30-minute computer classes with teacher and/or peer assistance will use the 

PowerPoint software application to create a 2-slide presentation, which will include use 

of text boxes, clip art, slide transitions and sound; and they will save the work in a file 

located in their work folder on the school server. 

 
Main Skill/Subordinate Skill Performance Objective 
1. Start Up PowerPoint Software 1. Given a powered down PC and monitor, the 3rd 

grade students will start up the PowerPoint software 
within two minutes. 

E1.1 Turn on Power to PC and monitor E1.1 Given a powered down PC and monitor and a 
teacher demonstration, the 3rd grade students will 
turn on power to PC and monitor in 1 attempt. 

E1.2 Log on to the Network E1.2 Given a powered up PC and monitor displaying 
a Login Screen and the student account information, 
the 3rd grade students will log on to the network in no 
more than 2 attempts. 

E1.3 Identify the different icons on the desktop E1.3 Given a displayed desktop with different 
software icons, the 3rd grade students will identify the 
different icons for Internet Explorer, MS Word and 
MS PowerPoint on the desktop. 

V1.3.1 Define icon V1.3.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “icon” to the 
corresponding graphical equivalent with no more 
than 1 assistive prompt. 

1.4 Select the PowerPoint icon on the Desktop 1.4 Given a desktop with different software 
application icons and a mouse, the 3rd grade 
students will select the PowerPoint icon on the 
desktop in no more than 2 attempts. 

1.5 Double-click the PowerPoint icon 1.5 Given a desktop with different software 
application icons and a mouse, the 3rd grade 
students double-click the PowerPoint icon with the 
left mouse button using no more than 3 attempts. 

2. Is a blank Slide displayed? 2. Given the definition of a Slide and an open copy of 
the PowerPoint software, the 3rd grade students will 
correctly determine if there is a blank slide displayed 
within 15 seconds. 
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Main Skill/Subordinate Skill Performance Objective 
V2.1 Define Slide V2.1 Given a list of technology terms and pictures of 

graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “Slide” to the 
corresponding graphical equivalent with no more 
than 1 assistive prompt. 

3. Insert a new Slide 3. Given the PowerPoint Insert menu, the 3rd grade 
students will insert a new slide within a period of 1 
minute. 

E3.1 Locate the Menu Bar E3.1 Given an opened version of PowerPoint or 
visual representation of the application, the 3rd grade 
students will locate the menu bar within 15 seconds. 

V3.1.1 Define menu V3.1.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “menu” to the 
corresponding graphical equivalent with no more 
than 1 assistive prompt. 

E3.2 Select menu choices using mouse E3.2 Given the PowerPoint menu bar and a specified 
menu choice, the 3rd grade students will select the 
correct menu choice using the mouse in 2 attempts.  

V3.2.1 Define menu choices V3.2.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “menu choices” 
to the corresponding graphical equivalent with no 
more than 1 assistive prompt. 

V3.2.2 Define submenu V3.2.2. Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “submenu” to 
the corresponding graphical equivalent with no more 
than 1 assistive prompt. 

3.3 Select the Insert menu 3.3 Given the PowerPoint Menu Bar, the 3rd grade 
students will select the Insert menu using the mouse 
to point and click using no more than 2 attempts. 

3.4 Select the Slide menu choice 3.4 Given the PowerPoint Insert menu, the 3rd grade 
students will select the Slide menu choice by using 
the mouse to point and click using no more than 2 
attempts. 

4. Set the Slide Layout 4. Given an open PowerPoint presentation with a 
slide displayed, the 3rd grade students will set the 
specified Slide Layout within 1 minute. 

4.1 Select the Format menu 4.1 Given the PowerPoint Menu Bar, the 3rd grade 
students will select the Format menu using the 
mouse to point and click using no more than 2 
attempts. 
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Main Skill/Subordinate Skill Performance Objective 
4.2 Select the Slide Layout menu choice 4.2 Given the PowerPoint Format menu, the 3rd 

grade students will select the Slide Layout menu 
choice by using the mouse to point and click using 
no more than 2 attempts. 

4.3 Select the specified Slide Layout format 4.3 Given the displayed Slide Layout choices, the 3rd 
grade students will correctly select the specified 
Slide Layout format within 30 seconds. 

V4.3.1 Define Slide Layout V4.3.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “Slide Layout” 
to the corresponding graphical equivalent with no 
more than 1 assistive prompt. 

5. Edit the Slide Content 5. Given a Slide Layout with text and graphic 
placeholders, the 3rd grade students will successfully 
edit the slide content for each slide within 6 minutes. 

5.1 Edit Text Box 5.1 Given a PowerPoint slide with a Slide Layout that 
contains a Text Box and instructions on what text to 
add, the 3rd grade students will successfully edit the 
text box within 3 minutes. 

V5.1.1 Define Text Box V5.1.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “Text Box” to 
the corresponding graphical equivalent with no more 
than 1 assistive prompt. 

5.1.2 Click in Text Box 5.1.2 Given Slide Layout with a Text Box 
placeholder, the 3rd grade students will click in the 
Text Box with the mouse using no more than 2 
attempts. 

5.1.3 Type Text 5.1.3 Given Text Box that has been selected for 
editing, the 3rd grade students will type the Text in 
the box within 2 minutes. 

5.2 Add Clipart 5.2 Given a PowerPoint slide with a Slide Layout that 
contains a Clipart Placeholder, the 3rd grade students 
will successfully add a single piece of Clipart within 3 
minutes. 

V5.2.1 Define Graphic Placeholder V5.2.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “Graphic 
Placeholder” to the corresponding graphical 
equivalent with no more than 1 assistive prompt. 

5.2.2 Click on Graphic placeholder 5.2.2 Given Slide Layout with a Clipart placeholder, 
the 3rd grade students will select the Graphic 
placeholder by clicking on it with the mouse in 2 
attempts. 
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Main Skill/Subordinate Skill Performance Objective 
5.2.3 Select the Insert Menu 5.2.3 Given the PowerPoint Menu Bar, the 3rd grade 

students will correctly display the Insert menu using 
the mouse to point and click in 2 attempts 

5.2.4 Select the Picture menu choice 5.2.4 Given the PowerPoint Insert menu, the 3rd 
grade students will select the Picture menu choice by 
using the mouse to point and click in 2 attempts. 

5.2.5 Select the Clipart menu choice 5.2.5 Given the PowerPoint Format Picture submenu 
displayed, the 3rd grade students will select the 
Clipart menu choice by using the mouse to point and 
click in 2 attempts 

V5.2.6 Define Clipart V5.2.6 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “Clipart” to the 
corresponding graphical equivalent with no more 
than 1 assistive prompt. 

5.2.7 Browse Clipart Library 5.2.7 Given the Clipart library displayed, the 3rd 
grade students will use the mouse and search bar to 
explore the available clipart images within a period of 
2 minutes. 

5.2.8 Select Clipart 5.2.8 Given the supplied choices for Clipart, the 3rd 
grade students will insert the selected Clipart image 
for the given slide in 2 attempts. 

6. Edit Slide Transition 6. Given a PowerPoint slide, the 3rd grade students 
will configure the Slide Transition by selecting a Slide 
Transition Type, Speed and Sound within 4 minutes. 

6.1 Select Slide Show menu 6.1 Given the PowerPoint Menu Bar, the 3rd grade 
students will correctly display the Slide Show menu 
using the mouse to point and click in 2 attempts. 

6.2 Select the Slide Transitions menu choice 6.2 Given the PowerPoint Slide Show menu, the 3rd 
grade students will select the Slide Transitions menu 
choice by using the mouse to point and click in 2 
attempts. 

6.3 Select a Slide Transition 6.3 Given the supplied choices for Slide Transitions, 
the 3rd grade students will, within 2 minutes, assign a 
Slide Transition for the given Slide. 

V6.3.1 Define Slide Transition V6.3.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “Slide 
Transition” to the corresponding graphical equivalent 
with no more than 1 assistive prompt. 
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Main Skill/Subordinate Skill Performance Objective 
6.4 Set the Transition Speed 6.4 Given the supplied choices for Transition Speed, 

the 3rd grade students will, within 30 seconds, assign 
a Transition Speed for the given Slide. 

6.5 Select a Transition Sound 6.5 Given the supplied choices for Transition 
Sounds, the 3rd grade students will, within 1 minute, 
assign a Transition Sound for the given Slide. 

7. Do you need another slide? 7.  Given the assignment to create a 2-slide 
PowerPoint presentation, the 3rd grade students will 
determine if they need to add an additional slide 
within 15 seconds. 

8. Preview the Slide Show 8.  Given a completed 2-slide PowerPoint 
presentation, the 3rd grade students will Preview their 
Slide Show within 3 minutes. 

8.1 Select the Slide Show menu 8.1 Given the PowerPoint Menu Bar, the 3rd grade 
students will correctly display the Slide Show menu 
using the mouse to point and click in 2 attempts. 

8.2 Select the View Slide Show menu choice 8.2 Given the PowerPoint Slide Show menu, the 3rd 
grade students will select the View Slide Show menu 
choice by using the mouse to point and click in 2 
attempts. 

9 Save the Presentation 9. Given a completed 2-slide PowerPoint 
assignment, the 3rd grade students will successfully 
save the file their student folder located on the 
school network within 3 minutes. 

9.1 Select the File menu 9.1 Given the PowerPoint Menu Bar, the 3rd grade 
students will correctly display the File menu using 
the mouse to point and click in 2 attempts. 

9.2 Select the Save As menu choice 9.2 Given the PowerPoint File menu, the 3rd grade 
students will select the Save As menu choice by 
using the mouse to point and click in 2 attempts. 

9.3 Select the directory of the student folder 9.3 Given the Save As dialogue box, the 3rd grade 
students will use the pull-down box to select the 
location of their student folder in 2 attempts. 

V9.3.1 Define file V9.3.1 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “file” to the 
corresponding graphical equivalent with no more 
than 1 assistive prompt. 
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Main Skill/Subordinate Skill Performance Objective 
V9.3.2 Define folder V9.3.2 Given a list of technology terms and pictures 

of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “folder” to the 
corresponding graphical equivalent with no more 
than 1 assistive prompt. 

V9.3.3 Define directory structure V9.3.3 Given a list of technology terms and pictures 
of graphical equivalents of these terms, the 3rd grade 
students will correctly match the term “directory 
structure” to the corresponding graphical equivalent 
with no more than 1 assistive prompt. 

9.4 Type a filename for the presentation 9.4 Given the Save As dialogue box with the 
destination location of the student folder selected, 
the 3rd grade students will type the specified filename 
in the filename line within 1 minute. 

9.5 Click Save 9.5  Given the Save As dialog box with the 
destination location selected and the specified 
filename typed, the 3rd grade students will click the 
Save button with 2 attempts. 

10. Shutdown the computer 10. Given a powered up PC & monitor, the 3rd grade 
students will shut down the computer and power off 
the monitor within 2 minutes. 

10.1 Click on the Start button 10.1 Given a powered up PC & monitor, the 3rd 
grade students will locate and click the Start button 
on the desktop in 2 attempts. 

10.2 Click Turn Off the Computer 10.2 Given a powered up PC & monitor with the Start 
menu displayed, the 3rd grade students will click on 
the Turn Off Computer menu choice in 2 attempts. 

10.3 Click Turn Off 10.3 Given a powered up PC & monitor with the Turn 
Off Computer dialogue box displayed, the 3rd grade 
students will click the Turn Off choice in 2 attempts. 

10.4 Power down the monitor 10.4 Given a shutdown PC, the 3rd grade students 
will turn off the monitor by pressing the power button 
in 1 attempt. 
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V. CRITERION REFERENCED ASSESSMENTS 
 

A. EVALUATION ITEMS PAIRED WITH OBJECTIVES 
 

Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

1. Start Up 
PowerPoint 
Software 

1. Given a powered down PC 
and monitor, the 3rd grade 
students will start up the 
PowerPoint software within 
two minutes. 

    (circle one) 
Checklist   Skill Performed 
Start Up PowerPoint Software     YES    NO 
(2 min) 

E1.1 Turn on 
Power to PC 
and monitor 

E1.1 Given a powered down 
PC and monitor and a teacher 
demonstration, the 3rd grade 
students will turn on power to 
PC and monitor in 1 attempt. 

 
Checklist   Skill Performed 
Turn on Power to Monitor         YES    NO 
(1 attempt) 

E1.2 Log on to 
the Network 

E1.2 Given a powered up PC 
and monitor displaying a Login 
Screen and the student 
account information, the 3rd 
grade students will log on to 
the network in no more than 2 
attempts. 

 
Checklist   Skill Performed 
Log on to the Network              YES    NO 
(2 attempts) 

E1.3 Identify 
the different 
icons on the 
desktop 

E1.3 Given a displayed 
desktop with different software 
icons, the 3rd grade students 
will identify the different icons 
for Internet Explorer, MS Word 
and MS PowerPoint on the 
desktop. 

Practice Test 
Match the icon on the left with the correct name of the 
program on the right.  Print the letter on the line 
provided: 
 
                                
 
A.      _____1.   Microsoft Word 
 
  
 
 
B.  _____2. Internet Explorer 
 
 
 
 
 
C.  _____ 3. Microsoft PowerPoint 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

V1.3.1 Define 
icon 

V1.3.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “icon” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Entry Skills Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn over your paper and 
make a list of your favorite things. 
 

_______  1. DIRECTORY 
_______  2. FILE 
_______  3. FOLDER 
_______  4. ICON 
_______  5. MENU 
_______  6. MENU BAR 
_______  7. MENU CHOICE 
_______  8. SUBMENU 

 
(see diagram on Entry Skills Test) 

1.4 Select the 
PowerPoint 
icon on the 
Desktop 

1.4 Given a desktop with 
different software application 
icons and a mouse, the 3rd 
grade students will select the 
PowerPoint icon on the 
desktop in no more than 2 
attempts. 

 
Checklist   Skill Performed 
Select the PowerPoint icon   YES    NO 
on the Desktop (2 attempts) 

1.5 Double-click 
the PowerPoint 
icon 

1.5 Given a desktop with 
different software application 
icons and a mouse, the 3rd 
grade students double-click 
the PowerPoint icon with the 
left mouse button using no 
more than 3 attempts. 

 
Checklist   Skill Performed 
Double-click the PowerPoint     YES    NO 
icon (3 attempts) 

2. Is a blank 
Slide 
displayed? 

2. Given the definition of a 
Slide and an open copy of the 
PowerPoint software, the 3rd 
grade students will correctly 
determine if there is a blank 
slide displayed within 15 
seconds. 

 
Product Rubric   POINTS 
Contains 2 slides    _______ 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

V2.1 Define 
Slide 

V2.1 Given a list of technology 
terms and pictures of graphical 
equivalents of these terms, the 
3rd grade students will correctly 
match the term “Slide” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Practice Test  
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn your paper in and 
continue working on your presentation. 
 

_______  1. CLIPART 
_______  2. GRAPHIC PLACEHOLDER 
_______  3. SLIDE 
_______  4. SLIDE LAYOUT 
_______  5. SLIDE TRANSITION 
_______  6. TEXT BOX 

 
(see diagram on Practice Test) 

3. Insert a new 
Slide 

3. Given the PowerPoint Insert 
menu, the 3rd grade students 
will insert a new slide within a 
period of 1 minute. 

 
Checklist   Skill Performed 
Insert a new Slide                    YES    NO 
(1 minute) 
 

E3.1 Locate the 
Menu Bar 

E3.1 Given an opened version 
of PowerPoint or visual 
representation of the 
application, the 3rd grade 
students will locate the menu 
bar within 15 seconds. 

 
Covered by assessment of objectives 3.3, 4.1, 
5.2.3, 6.1, 8.1 and 9.1. 

V3.1.1 Define 
menu 

V3.1.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “menu” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Entry Skills Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn over your paper and 
make a list of your favorite things. 
 

_______  1. DIRECTORY 
_______  2. FILE 
_______  3. FOLDER 
_______  4. ICON 
_______  5. MENU 
_______  6. MENU BAR 
_______  7. MENU CHOICE 
_______  8. SUBMENU 

 
(see diagram on Entry Skills Test) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

E3.2 Select 
menu choices 
using mouse 

E3.2 Given the PowerPoint 
menu bar and a specified 
menu choice, the 3rd grade 
students will select the correct 
menu choice using the mouse 
in 2 attempts.  

 
Covered by assessment of objectives 3.4, 4.2, 
5.2.4, 6.2, 8.2 & 9.2.  

V3.2.1 Define 
menu choices 

V3.2.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “menu choices” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Entry Skills Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn over your paper and 
make a list of your favorite things. 
 

_______  1. DIRECTORY 
_______  2. FILE 
_______  3. FOLDER 
_______  4. ICON 
_______  5. MENU 
_______  6. MENU BAR 
_______  7. MENU CHOICE 
_______  8. SUBMENU 

 
(see diagram on Entry Skills Test) 

V3.2.2 Define 
submenu 

V3.2.2. Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “submenu” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Entry Skills Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn over your paper and 
make a list of your favorite things. 
 

_______  1. DIRECTORY 
_______  2. FILE 
_______  3. FOLDER 
_______  4. ICON 
_______  5. MENU 
_______  6. MENU BAR 
_______  7. MENU CHOICE 
_______  8. SUBMENU 

 
(see diagram on Entry Skills Test) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

3.3 Select the 
Insert menu 

3.3 Given the PowerPoint 
Menu Bar, the 3rd grade 
students will select the Insert 
menu using the mouse to point 
and click using no more than 2 
attempts. 

 
Checklist   Skill Performed 
Select the Insert menu              YES    NO 
(2 attempts) 

3.4 Select the 
Slide menu 
choice 

3.4 Given the PowerPoint 
Insert menu, the 3rd grade 
students will select the Slide 
menu choice by using the 
mouse to point and click using 
no more than 2 attempts. 

 
Checklist   Skill Performed 
Select the Slide menu choice     YES    NO 
(2 attempts) 

4. Set the Slide 
Layout 

4. Given an open PowerPoint 
presentation with a slide 
displayed, the 3rd grade 
students will set the specified 
Slide Layout within 1 minute. 

 
Checklist   Skill Performed 
Set the Slide Layout        YES     NO 
(1 minute) 

4.1 Select the 
Format menu 

4.1 Given the PowerPoint 
Menu Bar, the 3rd grade 
students will select the Format 
menu using the mouse to point 
and click using no more than 2 
attempts. 

 
Checklist   Skill Performed 
Select the Format menu              YES    NO 
(2 attempts) 

4.2 Select the 
Slide Layout 
menu choice 

4.2 Given the PowerPoint 
Format menu, the 3rd grade 
students will select the Slide 
Layout menu choice by using 
the mouse to point and click 
using no more than 2 
attempts. 

 
Checklist   Skill Performed 
Select the Slide Layout                 YES    NO 
menu choice (2 attempts) 

4.3 Select the 
specified Slide 
Layout format 

4.3 Given the displayed Slide 
Layout choices, the 3rd grade 
students will correctly select 
the specified Slide Layout 
format within 30 seconds. 

 
Checklist   Skill Performed 
Select the specified Slide             YES    NO 
Layout (30 seconds) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

V4.3.1 Define 
Slide Layout 

V4.3.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “Slide Layout” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Practice Test  
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn your paper in and 
continue working on your presentation. 
 

_______  1. CLIPART 
_______  2. GRAPHIC PLACEHOLDER 
_______  3. SLIDE 
_______  4. SLIDE LAYOUT 
_______  5. SLIDE TRANSITION 
_______  6. TEXT BOX 

 
(see diagram on Practice Test) 

5. Edit the Slide 
Content 

5. Given a Slide Layout with 
text and graphic placeholders, 
the 3rd grade students will 
successfully edit the slide 
content for each slide within 6 
minutes. 

 
Checklist   Skill Performed 
Edit the Slide Content       YES      NO 
(6 minutes) 

5.1 Edit Text 
Box 

5.1 Given a PowerPoint slide 
with a Slide Layout that 
contains a Text Box and 
instructions on what text to 
add, the 3rd grade students will 
successfully edit the text box 
within 3 minutes. 

 
Checklist   Skill Performed 
Edit Text Box (3 minutes)      YES     NO 
 
Product Rubric   POINTS 
Text Box contains specified Text _______ 

V5.1.1 Define 
Text Box 

V5.1.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “Text Box” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Practice Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn your paper in and 
continue working on your presentation. 
 

_______  1. CLIPART 
_______  2. GRAPHIC PLACEHOLDER 
_______  3. SLIDE 
_______  4. SLIDE LAYOUT 
_______  5. SLIDE TRANSITION 
_______  6. TEXT BOX 

 
(see diagram on Practice Test) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

5.1.2 Click in 
Text Box 

5.1.2 Given Slide Layout with 
a Text Box placeholder, the 3rd 
grade students will click in the 
Text Box with the mouse using 
no more than 2 attempts. 

 
Checklist   Skill Performed 
Click in Text Box       YES    NO 
(2 attempts) 

5.1.3 Type Text 5.1.3 Given Text Box that has 
been selected for editing, the 
3rd grade students will type the 
Text in the box within 2 
minutes. 

 
Checklist   Skill Performed 
Type Text  (2 minutes)                 YES    NO 
  

5.2 Add Clipart 5.2 Given a PowerPoint slide 
with a Slide Layout that 
contains a Clipart Placeholder, 
the 3rd grade students will 
successfully add a single piece 
of Clipart within 3 minutes. 

 
Checklist   Skill Performed 
Add Clipart (3 minutes)      YES     NO 
 
Product Rubric   POINTS 
Graphic placeholder contains  _______ 
Clipart from library. 
 

V5.2.1 Define 
Graphic 
placeholder 

V5.2.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “Graphic Placeholder” 
to the corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Practice Test  
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn your paper in and 
continue working on your presentation. 
 

_______  1. CLIPART 
_______  2. GRAPHIC PLACEHOLDER 
_______  3. SLIDE 
_______  4. SLIDE LAYOUT 
_______  5. SLIDE TRANSITION 
_______  6. TEXT BOX 

 
(see diagram on Practice Test) 

5.2.2 Click on 
Graphic 
placeholder 

5.2.2 Given Slide Layout with 
a Clipart placeholder, the 3rd 
grade students will select the 
Graphic placeholder by 
clicking on it with the mouse in 
2 attempts. 

 
Checklist   Skill Performed 
Click on Graphic                         YES    NO 
placeholder (2 attempts) 

5.2.3 Select the 
Insert Menu 

5.2.3 Given the PowerPoint 
Menu Bar, the 3rd grade 
students will correctly display 
the Insert menu using the 
mouse to point and click in 2 
attempts 

 
Checklist   Skill Performed 
Select the Insert Menu       YES    NO 
(2 attempts) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

5.2.4 Select the 
Picture menu 
choice 

5.2.4 Given the PowerPoint 
Insert menu, the 3rd grade 
students will select the Picture 
menu choice by using the 
mouse to point and click in 2 
attempts. 

 
Checklist   Skill Performed 
Select the Picture menu              YES    NO 
choice (2 attempts) 

5.2.5 Select the 
Clipart menu 
choice 

5.2.5 Given the PowerPoint 
Format Picture submenu 
displayed, the 3rd grade 
students will select the Clipart 
menu choice by using the 
mouse to point and click in 2 
attempts 

 
Checklist   Skill Performed 
Select the Clipart menu               YES    NO 
choice (2 attempts) 

V5.2.6 Define 
Clipart 

V5.2.6 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “Clipart” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Practice Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn your paper in and 
continue working on your presentation. 
 

_______  1. CLIPART 
_______  2. GRAPHIC PLACEHOLDER 
_______  3. SLIDE 
_______  4. SLIDE LAYOUT 
_______  5. SLIDE TRANSITION 
_______  6. TEXT BOX 

 
(see diagram on Practice Test) 

5.2.7 Browse 
Clipart Library 

5.2.7 Given the Clipart library 
displayed, the 3rd grade 
students will use the mouse 
and search bar to explore the 
available clipart images within 
a period of 2 minutes. 

 
Checklist   Skill Performed 
Browse Clipart Library     YES    NO 
(2 minutes) 

5.2.8 Select 
Clipart 

5.2.8 Given the supplied 
choices for Clipart, the 3rd 
grade students will insert the 
selected Clipart image for the 
given slide in 2 attempts. 

 
Checklist   Skill Performed 
Select Clipart                             YES    NO 
(2 attempts) 

6. Edit Slide 
Transition 

6. Given a PowerPoint slide, 
the 3rd grade students will 
configure the Slide Transition 
by selecting a Slide Transition 
Type, Speed and Sound within 
4 minutes. 

 
Checklist   Skill Performed 
Edit Slide Transition       YES   NO 
(4 minutes) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

6.1 Select Slide 
Show menu 

6.1 Given the PowerPoint 
Menu Bar, the 3rd grade 
students will correctly display 
the Slide Show menu using 
the mouse to point and click in 
2 attempts. 

 
Checklist   Skill Performed 
Select Slide Show menu     YES    NO 
(2 attempts) 

6.2 Select the 
Slide 
Transitions 
menu choice 

6.2 Given the PowerPoint 
Slide Show menu, the 3rd 
grade students will select the 
Slide Transitions menu choice 
by using the mouse to point 
and click in 2 attempts. 

 
Checklist   Skill Performed 
Select the Slide Transitions         YES    NO 
menu choice (2 attempts) 

6.3 Select a 
Slide Transition 

6.3 Given the supplied choices 
for Slide Transitions, the 3rd 
grade students will, within 2 
minutes, assign a Slide 
Transition for the given Slide. 

 
Checklist   Skill Performed 
Select a Side Transition                 YES    NO 
(2 minutes) 
 
Product Rubric   POINTS 
Slide has a Slide Transition  _______ 
 

V6.3.1 Define 
Slide Transition 

V6.3.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “Slide Transition” to 
the corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Practice Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn your paper in and 
continue working on your presentation. 
 

_______  1. CLIPART 
_______  2. GRAPHIC PLACEHOLDER 
_______  3. SLIDE 
_______  4. SLIDE LAYOUT 
_______  5. SLIDE TRANSITION 
_______  6. TEXT BOX 

 
(see diagram on Practice Test) 

6.4 Set the 
Transition 
Speed 

6.4 Given the supplied choices 
for Transition Speed, the 3rd 
grade students will, within 30 
seconds, assign a Transition 
Speed for the given Slide. 

 
Checklist   Skill Performed 
Set the Transition Speed              YES    NO 
(1 minute) 
 
Product Rubric   POINTS 
Slide has a Transition Speed  _______ 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

6.5 Select a 
Transition 
Sound 

6.5 Given the supplied choices 
for Transition Sounds, the 3rd 
grade students will, within 1 
minute, assign a Transition 
Sound for the given Slide. 

 
Checklist   Skill Performed 
Set the Transition Sound              YES    NO 
(1 minute) 
 
Product Rubric   POINTS 
Slide has a Transition Sound  _______ 
 

7. Do you need 
another slide? 

7.  Given the assignment to 
create a 2-slide PowerPoint 
presentation, the 3rd grade 
students will determine if they 
need to add an additional slide 
within 15 seconds. 

 
Product Rubric   POINTS 
Contains 2 slides    _______ 

8. Preview the 
Slide Show 

8.  Given a completed 2-slide 
PowerPoint presentation, the 
3rd grade students will Preview 
their Slide Show within 3 
minutes. 

 
Checklist   Skill Performed 
Preview the Slide Show              YES    NO 
(3 minutes) 

8.1 Select the 
Slide Show 
menu 

8.1 Given the PowerPoint 
Menu Bar, the 3rd grade 
students will correctly display 
the Slide Show menu using 
the mouse to point and click in 
2 attempts. 

 
Checklist   Skill Performed 
Select the Slide Show menu       YES    NO 
(2 attempts) 

8.2 Select the 
View Slide 
Show menu 
choice 

8.2 Given the PowerPoint 
Slide Show menu, the 3rd 
grade students will select the 
View Slide Show menu choice 
by using the mouse to point 
and click in 2 attempts. 

 
Checklist   Skill Performed 
Select the View Slide Show       YES    NO 
menu choice (2 attempts) 

9 Save the 
Presentation 

9. Given a completed 2-slide 
PowerPoint assignment, the 
3rd grade students will 
successfully save the file their 
student folder located on the 
school network within 3 
minutes. 

 
Checklist   Skill Performed 
Save the Presentation                YES    NO 
(3 minutes) 
 
Product Rubric   POINTS 
Presentation saved to a file  _______ 
 

9.1 Select the 
File menu 

9.1 Given the PowerPoint 
Menu Bar, the 3rd grade 
students will correctly display 
the File menu using the mouse 
to point and click in 2 attempts. 

 
Checklist   Skill Performed 
Select the File menu                  YES    NO 
(2 attempts) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

9.2 Select the 
Save As menu 
choice 

9.2 Given the PowerPoint File 
menu, the 3rd grade students 
will select the Save As menu 
choice by using the mouse to 
point and click in 2 attempts. 

 
Checklist   Skill Performed 
Select the Save As menu           YES    NO 
choice (2 attempts) 

9.3 Select the 
directory of the 
student folder 

9.3 Given the Save As 
dialogue box, the 3rd grade 
students will use the pull-down 
box to select the location of 
their student folder in 2 
attempts. 

 
Checklist   Skill Performed 
Select the directory of                 YES    NO 
the student folder (2 attempts) 

V9.3.1 Define 
file 

V9.3.1 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “file” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Entry Skills Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn over your paper and 
make a list of your favorite things. 
 

_______  1. DIRECTORY 
_______  2. FILE 
_______  3. FOLDER 
_______  4. ICON 
_______  5. MENU 
_______  6. MENU BAR 
_______  7. MENU CHOICE 
_______  8. SUBMENU 

 
(see diagram on Entry Skills Test) 

V9.3.2 Define 
folder 

V9.3.2 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “folder” to the 
corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Entry Skills Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn over your paper and 
make a list of your favorite things. 
 

_______  1. DIRECTORY 
_______  2. FILE 
_______  3. FOLDER 
_______  4. ICON 
_______  5. MENU 
_______  6. MENU BAR 
_______  7. MENU CHOICE 
_______  8. SUBMENU 

 
(see diagram on Entry Skills Test) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

V9.3.3 Define 
directory 
structure 

V9.3.3 Given a list of 
technology terms and pictures 
of graphical equivalents of 
these terms, the 3rd grade 
students will correctly match 
the term “directory structure” to 
the corresponding graphical 
equivalent with no more than 1 
assistive prompt. 

Entry Skills Test 
Match the letter of the items on each of the following 
pages with the correct term in the list below.  Print the 
letter on the line provided.  Each term will only be used 
once.  You will have 5 minutes to complete the test.  
When you are done, please turn over your paper and 
make a list of your favorite things. 
 

_______  1. DIRECTORY 
_______  2. FILE 
_______  3. FOLDER 
_______  4. ICON 
_______  5. MENU 
_______  6. MENU BAR 
_______  7. MENU CHOICE 
_______  8. SUBMENU 

 
(see diagram on Entry Skills Test) 

9.4 Type a 
filename for the 
presentation 

9.4 Given the Save As 
dialogue box with the 
destination location of the 
student folder selected, the 3rd 
grade students will type the 
specified filename in the 
filename line within 1 minute. 

 
Checklist   Skill Performed 
Type a filename for the              YES    NO 
presentation (1 minute) 

9.5 Click Save 9.5  Given the Save As dialog 
box with the destination 
location selected and the 
specified filename typed, the 
3rd grade students will click the 
Save button with 2 attempts. 

 
Checklist   Skill Performed 
Click Save                   YES    NO 
(2 attempts) 

10. Shutdown 
the computer 

10. Given a powered up PC & 
monitor, the 3rd grade students 
will shut down the computer 
and power off the monitor 
within 2 minutes. 

 
Checklist   Skill Performed 
Shut down the computer              YES    NO 
(2 minutes) 

10.1 Click on 
the Start button 

10.1 Given a powered up PC 
& monitor, the 3rd grade 
students will locate and click 
the Start button on the desktop 
in 2 attempts. 

 
Checklist   Skill Performed 
Click on the Start button              YES    NO 
(2 attempts) 

10.2 Click Turn 
Off the 
Computer 

10.2 Given a powered up PC 
& monitor with the Start menu 
displayed, the 3rd grade 
students will click on the Turn 
Off Computer menu choice in 
2 attempts. 

 
Checklist   Skill Performed 
Click Turn Off the Computer        YES    NO 
(2 attempts) 
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Main Skill/ 
Subordinate 

Skill 

Performance Objective Assessment Items 

10.3 Click Turn 
Off 

10.3 Given a powered up PC 
& monitor with the Turn Off 
Computer dialogue box 
displayed, the 3rd grade 
students will click the Turn Off 
choice in 2 attempts. 

 
Checklist   Skill Performed 
Click Turn Off                               YES    NO 
(2 attempts) 

10.4 Power 
down the 
monitor 

10.4 Given a shutdown PC, 
the 3rd grade students will turn 
off the monitor by pressing the 
power button in 1 attempt. 

 
Checklist   Skill Performed 
Power down the monitor              YES    NO 
(1 attempts) 
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B. ITEMS AND INSTRUMENTS 
 

The assessment of the learner includes four different instruments: the entry 

skills test, a practice test, the performance checklist and the product rubric.  

The entry skills test and the practice test are both targeted at assessing 

understanding of the vocabulary in terms of graphical equivalents.  Each of 

these instruments is designed to have the students match terms with items 

designated in screen captures or other images. 

 The performance assessment will be accomplished using the PowerPoint 

Lesson Performance Checklist.  Each item to be performed is listed along with 

the criterion in parentheses.  If the student performs the item, the instructor 

circles YES (on the individual format) or places a checkmark in the chart 

(condensed format) to indicate YES.  If they fail to perform the item, the 

instructor circles NO (individual format) or leaves the corresponding box blank 

(condensed format).  Each YES is worth 1 point and should be tallied to find 

the score for the performance assessment.   Based on the total score 

available, a range has been provided to assess where each student falls 

(Exceeds, Meets, Does Not Meet) in performance of these specific lesson 

objectives. 

The assessment of the work-product will be done using the PowerPoint 

Lesson Product Grading Rubric.  This will be done when the final work-product 

(PowerPoint presentation) is saved.  This rubric looks at the construction and 

content of the end product of the steps performed as a result of the instruction.  

Each part is identified and given appropriate point values, which are awarded if 
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the listed item(s) are present.  At this point in the instruction of this software 

application, it is more important that the students have learned how to add and 

modify these components.   Totals are added up and compared with the 

ranges for student performance (Exceeds, Meets, Does Not Meet) of the 

product objectives. 
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C. ANSWER KEY AND GRADING CRITERIA 
 
For each of the two tests (Entry Skills, Practice Test) answer keys have 

been provided.  On the student instrument, as well as the key, the grading 

criteria have been included.  The number of correct items is totaled to 

determine the score for the instrument.  The score is then checked against a 

scoring scale on the instrument to determine the level of performance 

(Exceeds, Meets, Does Not Meet) of the objectives based on the number 

correct.  The ranges on the scoring scale have been determined by converting 

the number of correct answers to a percentage correct and dividing ranges 

based roughly on a minimum percentage of 65-70% needed for Meeting the 

objectives and 85-90% for Exceeds the objectives. 

The Performance Checklist has a simple YES/NO rating for if a particular 

skill/subskill is performed.  Each YES has a point value of 1.  A scoring scale 

has been designated to determine the level of performance based on the total 

number of skills performed successfully.  The Product Rubric has a simple 

point system for each item that is present as part of the presentation.  These 

scores are totaled and also applied to a scoring scale. 
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VI. SELECTED INSTRUCTIONAL STRATEGY 
 

A. ATTENTION GETTERS 
 

Naturally, students that enter the computer lab are eager to sit down and 

immediately start working on the computer.  With the configuration of the room, 

where students are positioned facing away from the instructor, it is vital to get 

their attention and focus.  A nice multi-media presentation developed using 

PowerPoint will be displayed to demonstrate the things that can be done with 

this software tool.   They will be told that over time they will learn the skills to be 

able to make presentations like the one shown, but that they have to start with 

the basics first.  Then they will be shown a demonstration of one similar to the 

one that they will produce. 

B. MOTIVATION STRATEGIES 
 

Although demonstrating a presentation to the students will get their 

attention, it will be important to get their hands on the computer so that their 

attention does not wander.  After the initial demonstration, the instruction will 

follow a format to introduce concepts and have students follow along.  The 

challenge will be in that students will have to turn to watch and listen to the 

instructor and then turn back to their computers to complete the task.  Some 

students will lag behind; others will stay on task, while others will race ahead 

on their own.  Nonetheless, it is vital to keep them all in a hands-on mode.  

Those that are ready for the next step can be employed to assist students that 

are struggling. 
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Students can quickly experience success using this tool, which in turn will 

build confidence and motivate them to proceed with the instructional activities.  

Timely assistance is also a factor in keeping students experiencing difficulties 

from getting frustrated and bored.  This assistance should direct them through 

the steps so that they will actually have a better chance of remembering the 

skill.  Simply having the instructor or a peer show them by doing it for them is 

not nearly as beneficial as having them go through the motions themselves. 

Students that complete the tasks ahead of time need activities to keep them 

from being bored as well.  They can be given instructions on how to guide 

peers through the steps where they are experiencing problems.  If they 

complete the lesson early, there are several options for keeping them engaged.  

They can either continue assisting peers, work on an additional project  or be 

allowed some free time playing with educational software or approved 

educational websites.   

Although, the instruction of this material is not dependent on the choice of 

content for the slide presentation, the selection of content can have an impact 

on motivation.   For example, students may be more motivated if they are 

instructed to include information about themselves, such as favorite colors, 

favorite subject, hobbies, etc.  They can also be encouraged to select clipart 

images that represent things they like.  This makes the project a personal 

creation, which is also very relevant. 
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C. MAKING INSTRUCTION RELEVANT TO LEARNERS 
 

The PowerPoint software in its very nature is highly visual which appeals to 

students of any age.  In the age of television and video games, technological 

tools that utilize a graphical basis appeal to students.  All of the interesting bells 

and whistles, such as slide transition effects, background formats and use of 

graphics/photos are a strong draw to these students.  At this introductory level, 

the basic features of the tool are being introduced.  The focus is more on if they 

can add the features, rather than how the features are utilized. 

The visual nature of this tool can be beneficial from students that experience 

difficulty with written reports.  Although not intended as a substitute for learning 

writing skills, PowerPoint provides students an alternative for reporting 

information on a variety of topics.  This may be especially beneficial for 

students with learning disabilities. 

For elementary students, learning technological skills will be relevant 

throughout their lives.   In the case of PowerPoint, this tool will be utilized in 

their school work as an alternative medium for making reports and 

presentations in their classes.  Although there is a concern among some 

educators as to the benefit of this tool, it is still very prevalent in the school 

classrooms, college campuses, corporate board rooms, and community level 

meetings. 
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D. RATING SCALE FOR FEEDBACK TO LEARNERS 
 

Feedback to the learners will be in two forms.  The first will occur during the 

instruction as they are allowed to practice each of the new skills.  This lesson 

relies heavily on performance of computer skills related to use of PowerPoint 

software and the steps required produce the end-product.  Students will be led 

through each of the steps and provided with verbal feedback related to how 

they are performing.  Feedback will follow a basic model format: 

If the user: Performed 
the Skill 

Example feedback would be: 

Successfully executes the 
step.  

YES “I see that many of you have started up 
PowerPoint successfully.  If you managed 
to do so, please check with your neighbors 
to see if they need help.  Remember to tell 
them the steps and have them do it 
themselves.” 

Is struggling with the step.  possible 
YES 

“I see that a few people are having 
problems inserting a slide.  Please turn 
your attention to the screen and I’ll 
demonstrate the steps again. “ 

Still struggling after 
additional demonstration. 

NO “I see that a few people are having 
problems inserting a slide.  Please turn 
your attention to the screen and I’ll 
demonstrate the steps again.  If you still 
need help, raise your hand and I or 
another student will walk you through the 
steps.” 

Has fallen far behind in 
executing several of the 
steps.  

NO “Jenny, I see that you are having some 
problems.  Let me get everyone else 
started on their project and I will work with 
you one-on-one.” 
OR “Mike is way ahead.  I’m going to have 
him show you how to do the steps to get 
you caught up.” 

 

Students will also have feedback from posttests in the form of a 

performance checklist and a product rubric.  Each will have points awarded 
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and a scoring scale for determining if students meet or exceed the objectives of 

the lesson. 

The performance checklist will follow all the steps/substeps that need to be 

performed as part of practice.  If the step is performed without within the criteria 

indicated, it is checked off (YES).  If the learner fails to perform the step within 

the criteria, thus requiring more than minor assistance, the step is considered 

as not performed (NO).   After all the steps have been assessed (YES/NO) the 

points will be totaled (YES=1, NO=0) and the following scale will be used to 

inform students how well they did.  Students will also be given feedback on 

which skills they were did not perform.  Originally, each step was going to be 

scored on a 3-pt. rating scale but it was too cumbersome of a system for the 

class size and time constraints. 

PERFORMANCE CHECKLIST FEEDBACK SCALE 
Exceeds Performance Objectives = 37-43 
Meets Performance Objectives = 30-36 
Does Not Meet Performance Objectives = 29 and below 
 

 The product rubric will cover the assessment of the presentation produced 

as a result of the instruction.  It is another form of a posttest than can be used 

to assess mastery of the objectives.  Again, the content items for this rubric are 

given different point values that are awarded if the content is there and not 

awarded if they are absent.  At this beginning stage, it is more about whether 

the features of PowerPoint have been added or modified rather than the quality 

of the content.  Students are provided with a copy of the rubric in the form of 

the assignment that they will use to apply the skills learned.  Points will be 

tallied and the following scale will be used to inform students how well they did.  
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Students will see from the rubric grade sheet what items/features are missing 

from their presentation. 

PRESENTATION PRODUCT RUBRIC FEEDBACK SCALE: 
Exceeds Performance of Objectives = 21-25 
Meets Performance of Objectives = 17-21 
Does Not Meet Performance of Objectives = 16 & below 
 

Learners will also be given the Entry Skills Test and a Practice Test to 

assess the verbal information associated this instruction.   After taking each of 

these tests, we will go over the information as a review/reinforcement of the 

terminology.  This will provide students immediate feedback as to the answers 

prior to additional instruction or practice of the skills. 

E. FOLLOW THROUGH ACTIVITIES TO REINFORCE LEARNING 
 

Instruction on this topic is a foundation for application and practice, as well 

as future instruction on additional features of the PowerPoint software 

application.  These future lessons will give struggling students additional 

practice at mastering the skills/subskills that they were not able to perform on 

their own.   Students who excel will be given project extensions to challenge 

them and thus keep them motivated.  They may also be allowed to do 

additional presentations on a topic of their choosing. 

Subsequent computer sessions during the year will be coordinated with the 

3rd grade teachers who will supply subject matter as the basis for additional 

practice preparing projects using PowerPoint.  Additional features of this tool 

will also be taught over the course of grades 3-5 and each session will build on 

the previously learned skills. 
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